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BAB I 

PENGENALAN ALAT UKUR 
 

Tujuan 

Tujuan dari praktikum ini adalah sebagai berikut: 

a. Mahasiswa mampu menjabarkan fungsi dari alat ukur tanah dan pemetaan wilayah 

beserta bagian-bagiannya 

b. Mahasiswa mampu mendeskripsikan kelemahan dan keunggulan alat ukur tanah  

c. Mahasiswa dapat menggunakan dengan benar alat-alat ilmu ukur tanah. 

d. Mahasiswa dapat mandiri mencari informasi tambahan tentang perkembangan 

teknologi alat-alat pengukuran tanah. 

 

Dasar konsep 

Pengukuran merupakan suatu aktifitas dan atau tindakan membandingkan suatu 

besaran yang belum diketahui nilainya atau harganya terhadap besaran lain yang sudah 

diketahui nilainya, misalnya dengan besaran standar (SI atau SNI). Alat pembandingnya 

disebut sebagai alat ukur.Kegiatan pengukuran banyak sekali dilakukan dalam bidang 

pertanahan (agraria), teknik sipil atau industri.Alat ukurnya pun banyak sekali jenisnya, 

tergantung dari banyak faktor, misalnya objek yang diukur serta hasil yang di inginkan. 

Ilmu ukur tanah adalah bagian dari ilmu geodesi yang mempelajari cara-cara 

pengukuran di permukaan bumi dan di bawah tanah untuk berbagai keperluan seperti 

pemetaan dan penentuan posisi relatif pada daerah yang relatif sempit sehingga unsur 

kelengkungan permukaan buminya dapat diabaikan (Basuki, 2012).Menurut Wongsotjitro 

(1980), arti melakukan pengukuran tanah adalah menentukan unsur-unsur (jarak dan sudut) 

titik yang ada di suatu daerah dalam jumlah yang cukup, sehingga daerah tersebut dapat 

digambar dengan skala tertentu. 

Ilmu ukur tanah memiliki tiga unsur yang harus diukur di lapangan, yaitu: jarak 

antara dua titik, beda tinggi dan sudut arah. Pengukuran yang dilakukan dengan 

menggunakan alat ukur sederhana sering disebut pula dengan istilah pengukuran secara 

langsung karena hasilnya dapat diketahui sesaat setelah selesai pengukuran.Sebagai contoh 

alat tersebut adalah pita ukur, bak ukur, yalon dan abney level. Selain alat ukur sederhana 

terdapat alat lain yang digunakan untuk pengukuran dilapangan yang dikenal dengan 

tacheometer. Tacheometer merupakan alat pengukuran cepat yang dilengkapi oleh 

peralatan optis, misalnya lensa sehingga dapat melakukan pengukuran secara optis. 

Sebagai contoh adalah compass survey, waterpass dan theodolit.  

Penggunaan dan perlakuan seorang surveyor terhadap alat merupakan hal yang 

penting dan harus diperhatikan.Penggunaan alat yang tidak tepat dapat mengakibatkan 

hasil pengukuran yang salah.Cara perawatannya pun harus diperhatikan agar alat ukur 

tanah tidak rusak.Alat ukur tanah merupakan alat-alat yang harganya cukup mahal. 

Penguasaan mengenai bagian-bagian dari masing-masing alat tersebut penting, sebab akan 

berpengaruh dengan kemampuan si pengukur dalam mengoperasikan alat tersebut 

nantinya. Oleh karena itu, praktikum mengenai “Pengenalan Alat” dilakukan agar bagian-

bagian dan fungsi dari alat ukur wilayah dapat diketahui 

 

Alat dan Bahan 

Alat-alat yang akan digunakan dalam praktikum ilmu ukur tanah dan pemetaan wilayah 

adalah sebagian berikut: 
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1. Kompas 

 

 

2. Pita Ukur 

 

 
3. Waterpass 
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4. Theodolite 

 

 

 

5. GNSS (Global Navigation Satellite System) 
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6. Alat pengukur kelerengan 

 

 

 

 

 

 

 

 

 

 

 

 

Abney level

 

Clinometer 

7. Alat penunjang lain  

 Rambu Ukur (Bak Ukur) 

 

Unting-Unting 
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 Kaki tiga (statif) 

 

 

 
 

Metode 
a. Pengertian alat dan cara penggunaaannya akan dijelaskan oleh pembimbing 

praktikum. 

b. Menggambar alat-alat tersebut lengkap dengan keterangan detail dan fungsinya. 

c. Carilahreferensi lain untuk menambah keterangan dari gambar tersebut. 

d. Pada pertemuan ke-2, setiap kelompok menerangkan hasil pekerjaannya dan 

didampingi pembimbing praktikum ketika praktikan kurang faham. 
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BAB II 

ILMU UKUR TANAH 
 

Tujuan 

Tujuan dari praktikum ini adalah sebagai berikut: 

a. Mahasiswa mampu menjelaskan satuan unit pengukuran tanah (jarak, sudut vertikal, 

sudut horizontal, keliling dan luas)   

b. Mahasiswa mampu mendeskripsikan cara-cara konversi unit-unit pengukuran tanah  

c. Mahasiswa dapat melakukan penghitungan data pengukuran tanah. 

 

Dasar konsep 

Ilmu ukur tanah adalah bagian rendah dari ilmu Geodesi, yang merupakan suatu 

ilmu yang mempelajari ukuran dan bentuk bumi dan menyajikannya dalam bentuk tertentu. 

Ilmu Geodesi ini berguna bagi pekerjaan perencanaan yang membutuhkan data-data 

koordinat dan ketinggian titik lapangan. 

Berdasarkan ketelitian pengukurannya, ilmu Geodesi terbagi atas dua macam, 

yaitu : 

1. Geodetic Surveying, yaitu suatu survey yang memperhitungkan kelengkungan bumi 

atau kondisi sebenarnya. Geodetic Surveying ini digunakan dalam pengukuran daerah 

yang luas dengan menggunakan bidang hitung yaitu bidang lengkung (bola/ellipsoid). 
2. Plane Surveying, yaitu suatu survey yang mengabaikan kelengkungan bumi dan 

mengasumsikan bumi adalah bidang datar. Plane Surveying ini digunakan untuk 

pengukuran daerah yang tidak luas dengan menggunakan bidang hitung yaitu bidang 

datar. 
Dalam praktikum ini kita memakai Plane Surveying (Ilmu Ukur Tanah). Ilmu 

Ukur tanah dianggap sebagai disiplin ilmu, teknik dan seni yang meliputi semua metoda 

untuk pengumpulan dan pemrosesan informasi tentang permukaan bumi dan lingkungan 

fisik bumi yang menganggap bumi sebagai bidang datar, sehingga dapat ditentukan posisi 

titik-titik di permukaan bumi. Dari titik yang telah didapatkan tersebut dapat disajikan 

dalam bentuk peta. 
Dalam prakteknya, perbedaan ilmu Geodesi dan Ilmu Ukur Tanah terletak pada 

metoda hitungan yang digunakan, Luas daerah yang di ukur dan di petakan, serta tingkat 

ketelitian ukuran yang di perlukan. Sedangkan dasar-dasar metoda pengukuran yang 

digunakan, pada dasarnya hampir sama. 
Sehingga dengan demikian dalam prosedur pengukuran tanah datar (Ilmu Ukur 

Tanah) yang memerlukan ketelitian tinggi untuk suatu proyek, dapat saja digunakan 

metoda-metoda ilmu Geodesi. 
Ilmu ukur tanah memiliki tiga unsur yang harus diukur di lapangan, yaitu: jarak 

antara dua titik, beda tinggi dan sudut arah. Pengukuran lapangan harus didasarkan atas 

konsep yang benar dan latihan pengukuran/analisis data jarak, sudut arah, dan sudut vertical 

(beda tinggi). Oleh karena itu praktikum kali ini akan lebih pada penyelesaian 

penghitungan/analisi data pada suatu contoh kasus. 

 

Alat dan Bahan 

Alat dan bahan yang akan digunakan dalam praktikum ini adalah sebagian berikut: 

1. Pertanyaan-pertanyaan kasus yang harus diselesaikan 

2. Alat tulis 
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Metode 

a. Pengertian unit jarak, beda tinggi dan sudur akan dijelaskan oleh pembimbing 

praktikum. 

b. Pembimbing praktikum akan memberikan soal hitungan untuk sudur arah, beda 

tinggi dan penghitungan luas.  

c. Praktikan mendiskusikan cara-cara analisis contoh kasus yang diberikan oleh 

pembimbing praktikum dan menyelesaikannya, serta membuatnya dalam laporan 
 

 

 

Contoh Soal (bisa ditambah oleh pembimbing praktikum) : 

1. Nyatakan 1,98 radian dalam ukuran derajat ! 
2. Nyatakan 82 derajat dalam ukuran radian ! 
3. Nyatakan 56o 18’ 45”  ke  dalam ukuran sentisimal 
4. Nyatakan 131g36cg78cc  ke dalam ukuran seksagesimal 
5. Nyatakan 1,88 Radian ke dalam ukuran seksagesimal 
6. Jika sudut jurusan dari titik P ke Q mempunyai harga sinus negatif dan 

cosinus positif, tentukan arah titik Q tersebut dengan gambar ! 
7. Diketahui   

a. A (+15602,75; -80725,88)  
b. B (-25697,72; +26781,15) 

Gambar dan hitung Sudut Jurusan aab dan Jarak dab 

8. Diketahui :     
a. A (+15867,15; -20782,50)  
b. B (+82167,86; +18880,42)  
c. C (-21653,48; -36244,32)        
d. D (-18546,91; 46421,38)        
e. E (+43211,18; +92463,48) 
f. Hitung :Sudut Jurusan, Jarak dan Gambar Koordinat titik-titik 

Tersebut ! 
9. Diketahui     

a. A (+54321,25; -61749,62) 
b. B (-39882,12; +45967,40) 

 Gambar dan hitung Sudut Jurusan aba,  dan Jarak dab 

 
10. Diketahui Koordinat Titik P(-3042,86;-5089,16);  

Q(-6209,42;+1253,25);  
R(+1867,89;-3896,34) 

 Hitung : Sudut Jurusan apq apr dan aqr 
            Jarak dpq,  dpr, dan dqr  
 

11. Diketahui : Koordinat Titik B (+21210,46; +18275,80)  
Bila Jarak B ke A adalah 12460 m dan sudut Jurusan dari B ke A 
mempunyai harga tangen = akar 3 dan Cosinus sudut jurusannya 
mempunyai harga tanda negatif. Hitung Koordinat Titik A.  
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BAB III 

PENGUKURAN SEDERHANA MENGGUNAKAN POLYGON 

TERBUKA 

 

Tujuan 

Tujuan dari praktikum ini adalah sebagai berikut: 

a. Mahasiswa mampu melakukan pengukuran tanah dengan menggunakan alat-

alat pengukuran tanah sederhana. 

b. Mahasiswa mampu mengukur dan memetakan polygon terbuka. 

c. Mahasiswa mampu melakukan perhitungan data pengukuran tanah (jarak 

datar). 

 

Dasar Konsep 

Pengukuran tanah adalah suatu seni paling tua dan yang terpenting 

dipraktekan oleh manusia sejak dahulu kala sudah dirasakan perlunya menandai 

batas-batas dan pemetaan tanah.pengukuran tanah terus memainkan peran yang 

sangat penting didalam banyak cabang rekayasa. Sebagai contoh pengukuran 

diperlukan untuk merencanakan, membangun dan memelihara jalan raya, jalan 

baja, sistem penghubung cepat antar bangunan, jembatan tempat peluncuran roket 

dan lain-lain. 

Ilmu ukur tanah adalah ilmu, seni dan teknologi untuk menyajikan 

informasi bentuk permukaan bumi baik unsur alam maupun unsur buatan manusia 

pada bidang yang dianggap datar.Ilmu ukur tanah sering disebut Plane 

Surveying.Ilmu ukur tanah bagian dari geodesi Geodetic Surveying.Ilmu ukur 

tanah bertujuan untuk mengukur bagian-bagian dari permukaan bumi, jika 

panjang tidak melebihi 50 km maka disebut dengan plane surveying, sehingga 

titik itu dapat dibayangkan dan dapat digambarkan pada suatu bidang datar yaitu 

peta. 

 

Alat dan Bahan 

Alat dan bahan yang digunakan pada praktikum ini adalah kompas, tali rafia 20m 

(setiap 1m diberi tanda), busur penuh 380ᵒ, alat tulis (penggaris, penghapus, pensil 

dll) dan milimeter block dan tally sheet. 

 

Metode 

Cara kerja yang digunakan dalam praktikum ini adalah sebagai berikut: 

1. Menyiapkan alat dan bahan yang akan digunakan . 

2. Menentukan arah utara dilapangan dan letak utara pada milimeter block. 

3. Menentukan titik awal (T1) dilapangan, setelah itu membidik titik ikat 

(T0) yang memiliki kemungkinan untuk berpindah sangat minim dengan 

menggunakan kompas. Ukur jarak antara T1 dengan T0. 
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4. Melakukan pembidikan untuk mendapatkan T2. Pembidik berada pada T1 

dan tidak boleh berpindah sampai didapatkan nilai derajat yang sama 

antara pembidik 1 (azimut) dengan pembidik 2 (back azimut).  

5. Menarik tali rafia dari T1 ke T2 yang telah diberi tanda setiap 1 meternya 

untuk mengetahui jarak masing-masing titik , setelah didapatkan nilai 

derajat yang sama antara T1 dan T2. 

6. Melakukan pembidikan hingga sampai pada lokasi yang dituju. 

7. Masukan data yang telah didapatkan kedalam tally sheet. 

8. Menggambarkan sketsa area pengukuran kedalam milimeter block 

(menggambar sesuai arah mata angin pada lapangan) dengan 

menggunakan busur dan penggaris. 

9. Membuat laporan. 

 

NB: jika azimut lebih dari 180ᵒ maka dikurang 180 dan jika azimut kurang dari 

180ᵒ maka ditambah 180.  

 

Contoh Tally Sheet: 

 

Titik Azimuth(ᵒ) Back Azimuth(ᵒ) Jarak(m) 

To-T1 70ᵒ 250ᵒ 21 m 

T1-T2 330ᵒ 150ᵒ 18 m 

T2 - ... .... .... .... 
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BAB IV 

PENGUKURAN SEDERHANA MENGGUNAKAN POLYGON 

TERTUTUP 

 

Tujuan 

Tujuan dari praktikm pengukuran tanah ini adalah sebagai berikut: 

1. Mahasiswa mampu melakukan pengukuran tanah dengan menggunkaan alat-

alat pengukuran tanah sederhana. 

2. Mahasiswa mampu mengukur dan memetakan polygon tertutup. 

3. Mahasiswa mampu melakukan perhitungan data pengukuran tanah (jarak 

datar, keliling dan luas). 

 

Dasar Konsep 

Ilmu ukur tanah adalah ilmu, seni dan teknologi untuk menyajikan 

informasi bentuk permukaan bumi baik unsur alam maupun unsur buatan manusi 

pada bidang yang diangap datar. Ilmu ukur tanah sering disebut Plane Surveying 

apabila jarak tidak mlebihi 55 km, sehingga titik-titik tersbut dapat dibayangkan 

pada suatu bidang datar yaitu peta. Batasan datar ilmu ukur tanah cakupan 

wilayahnya yang relatif sempit yaitu berkisar antara 0,5ᵒ x 0,5ᵒ atau 55 km x 55 

km.  

Pengukuran tanah merupakan suatu kegiatan menentukan posisi atau letak 

titik diatas atau pada permukaan bumi.Definisi yang lebih berkembang adalah 

pekerjaan untuk menggambarkan keadaan fisik sebagian permukaan menyerupai 

keadaan sebenarnya. Produk yang sesuai adalah peta topografi, sedangkan jeni-

jenis pekerjaan yang sederhana antara lain mengukur jarak antara dua titik, 

mengukur panjang dan lebar sebidang lahan, dan mengukur lereng serta 

menggambarkan bentuk sebidang lahan (Wongsotjitro, 1980). 

Pengukuran tanah terus memainkan peran yang sangat penting didalam 

banyak cabang rekayasa.Sebagai contoh pengukuran yaitu untuk merencankan, 

membangun, dan memelihara jalan raya, jembatan dan lahan sebagainya. 

Pengukuran dan pemetaan polygon merupakan salah satu metode pengukuran dan 

pemetaan kerangka dasar horizontal untu memperoleh koordinat planimetris 

(X,Y) titik-titik ikat pengukuran. Metode polygon ini yang merupakan salah satu 

cara penentuuan posisi horizontal banyak titik dimana titik satu dengan yang 

lainnya dihubungkan satu sama lain dengan pengukuran sudut dan jarak sehingga 

membentuk rangkaian titik-titik (polygon). Untuk itu dilakukan pengkuran tanah 

dengan enggunakan polygon, salah satunya polygon tertutup yang titik awal dan 

akhirnya berada disatu titik yang sama.  
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Alat dan Bahan 

Alat dan bahan yang digunakan pada praktikum ini adalah kompas, tali rafia 

20m (setiap 1m diberi tanda), busur penuh 380ᵒ, alat tulis (penggaris, penghapus, 

pensil dll), milimeter block dan tally sheet. 

 

 

 

Metode 

Cara kerja yang digunakan dalam praktikum kali ini adalah sebagai berikut: 

1. Menyiapkan alat dan bahan yang akan digunakan. 

2. Menentukan titik awal (T1) 

3. Menentukan titik ikat (T0) dari titik awal (T1) 

4. Membidik titik ikat dari titik awal dengan menggunakan kompas. Sudut 

yang didapat merupakan azimuth. 

5. Membidik dari titik ikat ke titik awal dengan menggunakan kompas. Besar 

sudut yang didapat dinyatakan back azimuth. 

6. Mengukur jarak dari T1 ke T0 dengan menggunakan tali rafia. 

7. Membidik T2 dari T1 (pembidik dari T1 tidak boleh berpindah setelah 

membidik T0, hanya berbalik arah untuk menentukan T2). 

8. Meembidik T3 dari T2 (Pembidik pada T2 sebelumnya tidak boleh 

berpindah stelah mendapat sudut yang sama dengan T1, hanya berbalik 

arah untuk membidik T3) 

9. Memasukkan hasil data kedalam tally sheet 

10. Melakukan cara kerja yang sama dari cara kerja ke 7sampai pembidik 

kembali keT1. 

11. Memasukan semua data ke milimeter block da dinyatakan alam bentuk 

polygon tertutup. 

 

NB: jika azimut lebih dari 180ᵒ maka dikurang 180 dan jika azimut kurang dari 

180ᵒ maka ditambah 180.  

 

Contoh Tally Sheet: 

 

Titik Azimuth(ᵒ) Back Azimuth(ᵒ) Jarak(m) 

To-T1 70ᵒ 250ᵒ 21 m 

T1-T2 330ᵒ 150ᵒ 18 m 

T2 - ... .... .... .... 
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BAB V 

PEMEETAAN SEDERHANA MENGGUNAKAN GNSS (GPS) 

 

Tujuan 

Tujuan dari praktikum pemetaan sederhana menggunakan GNSS (GPS) yaitu: 

1. Praktikum menggunakan alat GNSS 

2. Praktikan mampu melakukan pemetaan polygon terbuka dan tertutup 

menggunakan GPS 

3. Praktikan mampu menggunakan pemetaan komputer untuk pemetaan digital. 

 

Dasar Konsep 

Berbagai rencana dalam bidang teknik seperti pembangunan jalan raya, 

kereta api, irigasi, daerah industri dan perumahan memerlukan referensi berupa 

berbagai data seperti lokasi, karakteristik lokasi dan sebagainya. Hal-hal yang 

berhubungan dengan lokasi tentu memiliki hubungan dengan luas yang hendak 

dikelola.Oleh karena itu, perlu dilakukan dengan mengadakan pengukuran. 

Pada dasarnya, untuk skala pengukuran pada wilayah yang luas, 

pengukuran bisa dilakukan hanya bermdalkan patok dan meteran.Namun jika 

pengukuran yang hendak dilakukan mencapai puluhan, ratusan bahkan ribuan 

meter, maka peralatan yang dibutuhkan harus bisa mencapai jarak tersebut dan 

biasanya alat tersebut sudah termasuk canggih. Contohnya GPS, Theodolit dan 

total station. 

Selain didukung dengan alat, metode pengukuran juga penting 

diperhatikan ketika hendak melakukan pengukuran.Metode pengukuran 

disesuaikan dengan kebutuhan pengukur.Salah satu metode pengukuran dalam 

ilmu ukur wilayah adalah metode pengukuran polygon. 

Polygon menggunakan serangkaian garis lurus yang menghubungkan titik 

dipermukaan bumi.Dalam pengukuran tersebut, panjang dan arah telah ditentukan 

dari pengukuran lapangan.Pengukuran polygon tersebut berhubungan dengan titik 

koordinat.Pengukuran polygon bertujuan untuk menetapkan koordinat sudut yang 

diukur, yang dapat diaplikasikan untuk menentukan posisi horizontal banyak 

titik.Berdassarkan uraiaan yang telah dijelaskan, praktikum mengenai Pemetaan 

Sederhana Menggunakan GNSS (GPS) dilakukan agar mengetahui pengukuran 

pemetaan. 

 

Alat dan Bahan 

Alat dan bahan yang digunakan pada praktikum ini adalah GPS, Tally sheet dan 

alat tulis. 

 

Metode 

Cara kerja yang dilakukan pada praktikum ini adalah sebagai berikut: 

1. Menyiapkan alat dan bahan yang digunakan. 
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2. Menentukan lokasi yang akan dilakukan untuk pemetaan  

3. Mengambil data titik koordinat pada wilayah yang telah ditentukan 

4. Memasukan data titik ke dalam Tally sheet 

5. Membuat laporan hasil praktikum 

Contoh Tally Sheet: 

No Terminal X Y 

T1 0526706 9407223 

T2 0526718 9407212 

... .... .... 
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BAB VI 

PENGUKURAN WILAYAH MENGGUNAKAN ALAT GPS 

 

Tujuan 

Tujuan dari praktikum ini adalah sebagai berikut: 

1. Mahasiswa mampu melakukan pengukuran wilayah dengan menggunakan alat 

GPS tangan. 

2. Mahasiswa mampu mengukur dan memetakan polygon terbuka menggunakan 

SIG. 

3. Mahasiswa mampu mengukur dan memetakan polygon tertutup menggunakan 

SIG. 

4. Mahasiswa dapat melakukan perhitungan data pengukuran tanah (jarak datar, 

keliling dan luas). 

 

Dasar Konsep 

Pengukuran tanah merupakan peran yang sangat penting didalam 

banyaknya cabang rekaayasa.Sebagai contoh pengukuran yaitu untuk 

merencanakan, memelihara dan membangun jembatan, jalan raya dan lain 

sebagainya.Dalam pengukuran ini diperlukan alat untuk mengukurnya.Pada 

wilayah yang relatif sempit pengukuran biasanya hanya dilakukan cukup 

menggunakan meteran, tali rafia dan patok.Tetapi untuk mengukur wilayah yang 

luasnya beratus-ratus atau beribu-ribu meter perlu memakai alat yang lebih 

modern, misalnya GPS (Walijatun, 2010). 

Pada perkembangan zaman akhir-akhir ini penggunaan teknologi informai 

semakin pesat.Hal ini menunjukan bahwa teknologi merupakan salah satu unsur 

penting dalam kehidupan manusia.Teknologi mencerminkan moderenisasi yang 

memicu pada persaingan untuk menjadi lebih baik atau yang terbaik.Dalam 

berbagai aspek, teknolohi telah menjadi bagian dari perkembangan hidup 

manusia.Dalam kemajuannya, kita lebih dituntut untuk dapat menguasai berbagai 

ilmu dibidang komputer salah satunya adalah Sistem Informasi Geografis (SIG). 

Pengukuran wilayah sangat penting dilakukan untuk mengetahui luasan 

wilayah yang akan digunakan dalam pembuatan gedung dan jalan. Pembuatan 

jalan dilakukan dengan membuat beberapa titik dengan menggunakan polygon 

terbuka, dapat dilakukan dengan menggunakan alat GPS. Begitupun dengan 

pembuatan gedung, akan tetapi menggunakan poligon tertutup. Hasil dari 

pengambilan titik menggunakan GPS tersebut akan diolah menggunakan software 

ArcGIS.ArcGIS merupakan salah satu software yang dikembangkan oleh ESRI 

(Environment Science and Research Institue) yang merupakan kompilasi fungsi-

fugsi dari berbgai maca software  GIS yang berbeda seperti GIS Desktop, GIS 

Server dan GIS berbasis web. Software ini dirilis oleh ESRI pada tahun 

2000.Produk utama dari ArcGIS adalah ArcGIS desktop (Rahmawati, 2006). 
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ArcGIS merupakan penggabungan, modifikasi dan peningkatan 2 software 

ESRI yang sudah terkenal sebelumnya yaitu ArcView GIS 3.3 dan Arc/Info 

workstation 7.2. ArcGIS merupakan perangkat lunak berbasis windows sebaagai 

berikut: ArcReader, ArcGIS desktop yang mewakili  lima tingkat lisensi, seperti 

ArcView, ArcMap, ArcEditor, ArcInfo, dan ArcCatalog (Rahmawati, 2006). 

 

Alat dan Bahan 

Alat dan bahan yang digunakan pada praktikum pada praktikum ini adalah 

GPS, alat tulis, software Ms. Excel dan ArcGIS 8.0 

 

Metode 

Cara kerja yang digunakan pada pembuatan polygon terbuka dari GSG 

menuju Balai Bahasa adalah sebagai berikut: 

 

MENGHUBUNGKAN FOLDER 

1. Buka Software ArcGIS 

2. Pilih  untuk menghubungkan folder tersimpan dengan software 

ArcGIS. 

 

NB: jika tidak ada bar catalog. Klik  pada toolbar. 

3. Pilih folder yang akan dihubungkan dengan software ArcGIS →OK 
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POLYGON TERBUKA 

- EKSPORT DATA TITIK 

1. Klik File →Add Data →Add XY Data  

 
 

2. Pilih untuk membuka folder yang menyimpan data titik. Pilih Sheet 

yang terdapat data titik GPS →Add 
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3. Lalu klik Edit 
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4. Klik Select →Projected Coordinate Systems →UTM →WGS 1984 

→Southern Hemisphere →WGS 1984 UTM Zone 48S →Add →Apply 

→OK.  
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5. Jika telah selesai akan muncul data seperti ini. 

 
6. Klik kanan pada Table of Contents (Sheets1) →Label Featuresakan 

muncul label pada setiap titik GPS. 
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7. Klik kanan pada Table of Contents (Sheets1) →Data →Export Data 

 

 
 

8. Klik untuk memilih folder menyimpan (pilih folder yang sudah 

dihubungkan tadi). Ganti Save as Type menjadi Shapefile →Save →OK. 
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9. Maka akan muncul hasil eksport pada Table of Contents 

 
 

- POINTS TO LINE 

1. Pilih →Data Management Tools →Features →Points to Line 
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2. Input Features: Masukan data yang telah dieksport (data shp). Output 

Feature Class: Pilih folder untuk menyimpan data. →OK. 
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3. Tunggu prosesnya. Jika proses berhasil akan muncul notifikasi seperti 

dibawah. 

 

 
 

4. Hasil dari proses Points to Line 

 

 
POLYGON TERTUTUP 
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- EKSPORT DATA TITIK 

 

1. Klik File →Add Data →Add XY Data  

 

 
 

2. Pilih untuk membuka folder yang menyimpan data titik. Pilih Sheet 

yang terdapat data titik GPS →Add 
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3. Lalu klik Edit 

 

 
 

4. Klik Select →Projected Coordinate Systems →UTM →WGS 1984 

→Southern Hemisphere →WGS 1984 UTM Zone 48S →Add →Apply 

→OK.  
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5. Jika telah selesai akan muncul data seperti ini. 

 
 

 

6. Klik kanan pada Table of Contents (Sheets1) →Label Featuresakan 

muncul label pada setiap titik GPS. 
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7. Maka akan tampil gambar seperti dibawah ini 

 
 

8. Klik kanan pada Table of Contents (Sheets1) →Data →Export Data 
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9. Klik untuk memilih folder menyimpan (pilih folder yang sudah 

dihubungkan tadi). Ganti Save as Type menjadi Shapefile →Save →OK. 

 
 

10. Maka akan muncul hasil eksport pada Table of Contents 
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- MEMBUAT SHP 

1. Klik kanan folder tersimpan yang ada di Catalog →New →Shapefile 

 
 

2. Ganti Name: LUAS, Feature Type:  Polygon →Edit 
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3. Klik Select →Projected Coordinate Systems →UTM →WGS 1984 

→Southern Hemisphere →WGS 1984 UTM Zone 48S →Add →Apply 

→OK. 
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4. Data Shapefile akan muncu di Table of Contents  

 
 

- MENGHITUNG LUAS POLYGON TERTUTUP 

1. Klik Start →Start Editing 

 

 
 

 

 

 

 

 

 

2. Pilih Luas →OK 
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3. Klik Editor →Editing Windows →Create Features 
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4. Klik SHP luas pada Create Features sebelah kanan → Pilih Polygon 

pada Construction Tools 

 
 

5. Klik  untuk menghubungkan titik-titik terminal. Seperti gambar 

dibawah ini. Jika telah terhubung semua. Klik Editor→Stop Editing 
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6. Klik kanan pada file SHP Luas di Table of Contents → Klik Open 

Attribute Table 

 
 

7. Klik →Add Field 
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8. Ganti Name: Luas Type: Double →OK 

 

 
 

 

9. Klik kanan pada kolom luas →Calculate Geometry 
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10. Klik OK 

 

 
 

11. Maka akan muncul luas Polygon Tertutup 
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BAB VII 

PEMETAAN MENGGUNAKAN CITRA SATELIT RESOLUSI TINGGI 

 

Tujuan 

Tujuan dari praktikum ini adalah sebagai berikut: 

1. Mahasiswa mampu memahami cara-cara menggunakan citra resolusi tinggi 

untuk kebutuhan pemetaan dalam skala besar. 

2. Mahasiswa mampu melakukan operasi tumpang susun data (overlay). 

 

Dasar Konsep 

Dewasa ini kemajuan teknologi sangat pesat, ini juga berpengaruh pada 

perkembangan ilmu pengetahuan. Ilmu perpetaan adalah salah satu ilmu yang 

sangat besar dipengaruhi oleh kemajuan teknologi tersebut ditandai dengan proses 

perekaman jarak jauh ini dikenal perekamannya melalui satelit. Peta yang 

dihasilkan oleh perekaman jarak jauh ini dikenal dengan nama citra penginderaan 

jauh. Namun pada dasarnya citra satelit dengan peta mempunyai perbedaan yang 

mencolok dan tidak bisa dikatakan sama (Soedarso, 1998). 

Perkembangan teknologi yang sangat pesat ini membawa dampak positif bagi 

manusia.Karena penelitian yang dilakukan tersebut tanpa harus terjun langsung 

melainkan hanya melihat pada citra tersebut.Pemetaan dengan citra satelit tersebut 

bertujuan untuk mengambil data dan informasi dari citra foto maupun nonfoto 

dari berbagai objek yang ada dipermukaan bumi. Citra penginderaan jauh antara 

lain berupa foto udara, Citra Landsat, Citra SPOT, Citra Quickbird, dan Citra 

EKONOS (Rahmawati, 2006).Untuk mengimbangi laju perubahan informasi 

geografis, dapat digunakan data satelit penginderaan jauh dan informasi ini dapat 

ditampilkan dalam suatu sistem yang disebut dengan Sistem Informasi Geografis 

(SIG).  

 

Alat dan Bahan 

Alat dan bahan yang digunakan pada praktikum ini adalah GPS, Alat Tulis, 

software ArcGIS, dan software Google Earth. 

 

Metode 

Cara kerja yang dilakukan pada praktikum ini adalah: 
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MENAMPILKAN DATA 

1. Buka software ArcGIS 

2. Pilih  untuk menghubungkan folder tersimpan dengan software 

ArcGIS. 

 

 

NB: jika tidak ada bar catalog. Klik  pada toolbar. 

 

3. Pilih folder yang akan dihubungkan dengan software ArcGIS →OK 
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4. Klik  pada toolbar →pilih data yang akan diolah →ADD 

 

 
 

MENGATUR KOORDINAT SISTEM 

 

1. Klik View→Data Frame Propertis 
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2. Klik Coordinate System →Predefined →Projected Coordinate System. 

 

 
 

3. Pilih UTM →WGS 1984 →Southern Hemisphere →WGS 1984 UTM 

Zone 48S →OK. 
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MELAKUKAN GEOKOREKSI 

1. Menyiapkan koordinat sistem yang akan digunakan untuk geokoreksi 

2. Zoom in  pada data yang akan digeokoreksi. 

3. Klik tools Add Control Points pada bagian bawah page. 

4. Arahkan kursor bertanda + menuju daerah yang sesuai dengan titik 

koordinat. Klik pada wilayah yang sesuai lalu klik kanan untuk input 

koordinat sistem x dan y. 

 

 
 

5. Input koordinat sistem X dan Y →OK 
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Contoh: X= 526494.000000, Y= 9407444.000000 

NB: Klik kanan pada layer jpg, jika jpg tidak muncul. Klik kanan→Zoom To 

Layer. 

 
Akan muncul tanda + pada daerah yang telah dilakukan geokoreksi. Lakukan 

geokoreksi minimal sebanyak 4 titik yang menyebar merata diareal yang akan 

dipetakan.  
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6. Klik dibagian bawah layer untuk menyimpan data titik geokoreksi 

yang telah diambil. Jika Total RMS Error dibawah 0,10 maka proses 

geokoreksi dilakukan secara baik. 
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7. Klik Save → pilih folder yang akan digunakan untuk menyimpan data titik 

geokoreksi → Klik Save → Lalu OK. 

 

 
OVERLAY DATA 

 

1. Klik →Add Data 

 
 

2. Pilih folder →Klik data Polygon→Add 
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3. Add semua data seperti gambar dibawah ini 

 
4. Tampilan hasil akhir  
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BAB VIII 

PENGUKURAN TANAH  MENGGUNAKAN 

DIGITAL THEODOLIT 

  

8.1 Tujuan 

Tujuan dari praktikum ini adalah sebagai berikut: 

d. Mahasiswa mampu melakukan pengukuran tanah dengan menggunakan alat-

alat pengukuran tanah Theodolit 

e. Mahasiswa mampu mengukur dan memetakan polygon terbuka menggunaan 

alat pengukuran tanah Theodolit. 

f. Mahasiswa mampu mengukur dan memetakan polygon tertutup menggunaan 

alat pengukuran tanah Theodolit. 

 

 

8.2 Dasar Konsep 

Pengukuran tanah adalah suatu seni paling tua dan yang terpenting 

dipraktekan oleh manusia sejak dahulu kala sudah dirasakan perlunya menandai 

batas-batas dan pemetaan tanah.pengukuran tanah terus memainkan peran yang 

sangat penting didalam banyak cabang rekayasa.Sebagai contoh pengukuran 

diperlukan untuk merencanakan, membangun dan memelihara jalan raya, jalan 

baja, sistem penghubung cepat antar bangunan, jembatan tempat peluncuran roket 

dan lain-lain. 

Ilmu ukur tanah adalah ilmu, seni dan teknologi untuk menyajikan 

informasi bentuk permukaan bumi baik unsur alam maupun unsur buatan manusia 

pada bidang yang dianggap datar.Ilmu ukur tanah sering disebut Plane 

Surveying.Ilmu ukur tanah bagian dari geodesi Geodetic Surveying.Ilmu ukur 

tanah bertujuan untuk mengukur bagian-bagian dari permukaan bumi, jika 

panjang tidak melebihi 50 km maka disebut dengan plane surveying, sehingga 

titik itu dapat dibayangkan dan dapat digambarkan pada suatu bidang datar yaitu 

peta. 

 

8.3  Alat dan Bahan 

Alat dan bahan yang digunakan pada praktikum ini adalah kompas, tali rafia 20m 

(setiap 1m diberi tanda), busur penuh 380ᵒ, alat tulis (penggaris, penghapus, pensil 

dll) dan milimeter block dan tally sheet. 

 

8.4  Metode 

Cara kerja yang digunakan dalam praktikum ini adalah sebagai berikut: 

10. Menyiapkan alat dan bahan yang akan digunakan . 

11. Menentukan arah utara dilapangan dan letak utara pada milimeter block. 

12. Menentukan titik awal (T1) dilapangan, setelah itu membidik titik ikat 

(T0) yang memiliki kemungkinan untuk berpindah sangat minim dengan 

menggunakan kompas. Ukur jarak antara T1 dengan T0. 
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13. Melakukan pembidikan untuk mendapatkan T2. Pembidik berada pada T1 

dan tidak boleh berpindah sampai didapatkan nilai derajat yang sama 

antara pembidik 1 (azimut) dengan pembidik 2 (back azimut).  

14. Menarik tali rafia dari T1 ke T2 yang telah diberi tanda setiap 1 meternya 

untuk mengetahui jarak masing-masing titik , setelah didapatkan nilai 

derajat yang sama antara T1 dan T2. 

15. Melakukan pembidikan hingga sampai pada lokasi yang dituju. 

16. Masukan data yang telah didapatkan kedalam tally sheet. 

17. Menggambarkan sketsa area pengukuran kedalam milimeter block 

(menggambar sesuai arah mata angin pada lapangan) dengan 

menggunakan busur dan penggaris. 

18. Membuat laporan. 
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TALLY SHEET PENGUKURAN MENGGUNAKAN 

DIGITAL THEODOLIT 

 

Kelompok  : 

Lokasi Pengukuran : 

 

No Titik Benang 

Tengah 

Benang 

Atas 

Benang 

Bawah 

Horizontal Vertikal 
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BAB 1X 

PENGENALAN 

SISTEM INFORMASI GEOGRAFIS (SIG) 

 

9.1.Dasar Teori 

Sistem Informasi Geografis merupakan sistem yang terdiri dari perangkat keras, 

perangkat lunak, data, manusia, organisasi atau lembaga yang digunakan untuk 

mengumpulkan, menyimpan, menganalisis dan menyebarkan informasi-informasi 

mengenai daerah-daerah dipermukaan bumi (Crisman et al., 2009). Selain itu, 

menurut Aronoff (1989), Sistem Informasi Geografis merupakan sistem informasi 

berbasis komputer yang digunakan untuk mengolah dan menyimpan data atau 

informasi geografis. Ekadinata et al. (2008) menyatakan bahwa SIG merupakan 

sebuah sistem atau teknologi berbasis komputer yang dibangun dengan tujuan 

untuk mengumpulkan, menyimpan, mengolah dan menganalisa, serta menyajikan 

data dan informasi dari suatu obyek atau fenomena yang berkaitan dengan letak 

atau keberadaannya dipermukaan bumi.  

 

Secara umum pengertian SIG dapat diartikan sebagai berikut: 

”Suatu komponen yang terdiri dari perangkat lunak, data geografis dan 

sumberdaya manusia yang bekerja bersama secara efektif untuk memasukan, 

menyimpan, memperbaiki, memperbaharui, mengelola, memanipulasi, 

mengintegrasikan, menganalisa dan manampilkan data dalam suatu informasi 

berbasis geografis”. 

 

Jika dilihat dari pengertian menurut para ahli, SIG dapat dirinci menjadi beberapa 

sub-sistem yang saling berkaitan yang mencakup input data, manajemen data, 

pemrosesan atau analisis data, pelaporan (output)dan hasil analisa (Ekadinata et 

al., 2008).SIG mempunyai kemampuan untuk menghubungkan berbagai data pada 

suatu titik tertentu di bumi,menggabungkannya, menganalisa dan akhirnya 

memetakan hasilnya (GIS Konsorsium, 2007). Oleh karena itu penggunaan 

teknologi berbasis Sistem Informasi Geografis ini telah menjadi sarana atau alat 

bantu standar yang digunakan untuk mendukung proses pengambilan keputusan 

dan pembuatan kebijakan dalam pengelolaan sumberdaya alam (Ekadinata et al., 

2008). 

 

Sistem kerja SIG selalu diasosiasikan dengan sistem yang berbasis komputer. 

Penggunaan komputer ini akan sangat membantu ketika data geografis yang 

tersedia merupakan data dalam jumlah dan ukuran besar, dan terdiri dari banyak 

tema yang saling berkaitan (GIS Konsorsium, 2007). Data geografis pada 

dasarnya tersusun oleh dua komponen penting, yaitu Data Spasial dan Data 

Atribut. Data Spasial merepresentasikan posisi atau lokasi geografis dari suatu 

obyek dipermukaan bumi, sedangkan data atribut dapat berupa informasi numerik, 
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foto, narasi, dan lain sebagainya, yang diperoleh dari data statistik, pengukuran 

lapangan dan sensus, dan lain-lain (Ekadinataet al., 2008). 

 

Data spasial yang berbasis koordinat ini dapat diperoleh dari berbagai sumber 

yaitu antara lainnya adalah peta analog, data dari sistem penginderaan jauh (foto 

udara dan citra satelit), data hasil pengukuran lapangan, pengukuran theodolit dan 

pengukuran dengan menggunakan Global Positioning System(GPS) (Ekadiana et 

al., 2008 dan Prasetyo, 2011). Sumber data lain yang dapat ditambahkan adalah 

dengan cara sebagai berikut: 

a. Mengakses data dari lembaga pemerintahan (Badan Informasi Geospasial, 

BMKG, LAPAN, dll) 

b. Mendapatkandata dari Google Earth 

c. Mengunduh data yang sudah ada dari arsip data gratis (misalnya: USGS 

Earth Explorer, dll). 

 

Untuk dapat dipergunakan dalam SIG, data spasial perlu dikonversi kedalam 

format dijital. Terdapat dua model representasi data dalam format dijital, yaitu 

model vektor dan model raster. Kedua model mampu menyimpan detail informasi 

tentang lokasi serta atributnya. Perbedaan mendasar antara kedua model tersebut 

terletak pada cara penyimpanan serta representasi sebuah obyek geografis 

(Ekadinata et al., 2008).  

 

Data vektor merupakan bentuk bumi yang direpresentasikan ke dalam kumpulan 

garis, area (daerah yang dibatasi oleh garis yang berawal dan berakhir pada titik 

yang sama), titik dan nodes (merupakan titik perpotongan antara dua buah garis) 

(GIS Konsorium, 2007). Dengan menggunakan model vektor, obyek-obyek dan 

informasi dipermukaan bumi dilambangkan sebagai titik, garis atau poligon. 

Masing-masing mewakili tipe obyek tertentu sebagaimana dijelaskan berikut: 

a. Titik (point): merepresentasikan obyek spasial yang tidak memiliki 

dimensi panjang dan atau luas. Fitur ini direpresentasikan dalam satu 

pasangan koordinat x,y; untuk contoh stasiun curah hujan, titik ketinggian, 

observasi lapangan , titik sampel, 

b. Garis (lines/segment): merepresentasikan obyek yang memiliki dimensi 

panjang namun tidak mempunyai dimensi area, misalnya jaringan jalan, 

pola aliran, garis kontur, 

c. Poligon: merepresentasikan fitur spasial yang memiliki area contohnya 

unit administrasi, unit tanah, zona penggunaan lahan (Ekadinata et al, 

2008). 

 

Keuntungan utama dari format data vektor ini adalah ketepatan dalam 

merepresentasikan fitur titik, batasan dan garis lurus. Hal ini sangat berguna untuk 

analisis yang membutuhkan ketepatan posisi, contohnya pada basis data batas-
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batas kadastral. Kelemahan dari jenis data ini adalah ketidakmampuannya dalam 

mengakomodasikan perubahan gradual (GIS Konsorsium, 2007). 

 

Data raster merupakan representasi permukaan bumi yang tersusun dari sel/piksel 

sebagai satuan terkecilnya untuk menyimpan data keterangan secara implisit. Data 

raster seperti citra satelit (optik maupun radar), foto udara memiliki nilai di dalam 

setiap piksel datanya (Prasetyo, 2011). Pada data raster, resolusi (definisi visual) 

tergantung pada ukuran pikselnya. Dengan kata lain, resolusi piksel 

menggambarkan ukuran sebenarnya di permukaan bumi yang diwakili oleh setiap 

piksel pada citra. Semakin kecil ukuran permukaan bumi yang direpresentasikan 

oleh satu sel, semakin tinggi resolusinya. Data raster sangat baik untuk 

merepresentasikan batas-batas yang berubah secara gradual, seperti jenis tanah, 

kelembaban tanah, vegetasi, suhu tanah dan sebagainya. Keterbatasan utama dari 

data raster adalah besarnya ukuran file, semakin tinggi resolusi grid-nya semakin 

besar pula ukuran filenya dan sangat tergantung pada kapasitas perangkat keras 

yang tersedia (GIS Korosium, 2007). 

 

Secara umum, kedua model memiliki kelebihan dan kekurangannya masing-

masing. Pada penerapannya, sebuah obyek di permukaan bumi bisa dimodelkan 

sebagai vektor dan raster sekaligus. Pemilihan penggunaan model tergantung 

kepada tujuan dari pemodelan data tersebut. Hampir semua perangkat lunak SIG 

menyediakan fasilitas untuk mengubah format data vektor ke raster dan 

sebaliknya (Ekadinata et al., 2008). 

 

9.2.Tujuan Praktikum 

a. Praktikan mampu memahami konsep dasar dari Sistem Informasi 

Geografis (SIG) 

b. Praktikan mampu menjelaskan aplikasi SIG di bidang kehutanan melalui 

media massa dan internet. 

 

9.3.Metodologi 

a. Alat dan Bahan 

- 1 eksemplar makalah dari jurnal ilmiah di bidang kehutanan atau 

lingkungan. 

- 1 unit media audio visual yang diunduh dari kanal youtube atau audio 

visual lainnya yang menerangkan tentang SIG di bidang kehutanan 

b. Metode 

- Praktikan melakukan resume makalah. 

- Praktikan Melakukan resume terhadap video. 

 

9.4.Tugas 

Buat laporan praktikum dalam buku praktikum kelompok ! 
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BAB X 

DIGITASI DAN PENGEDITAN DATA 

 

10.1. Dasar Teori 

Analisis data menggunakan SIG membutuhkan masukan data yang relevan dan 

berkualitas (Ekadinata et al., 2008). Maka dari itu sumber data yang kita gunakan 

dalam SIG harus jelas dari mana data itu didapatkan, agar data yang kita gunakan 

dapat dipertanggung jawabkan. Pembuatan data dan proses mengintegrasikan data 

ke dalam SIG merupakan tahapan terpenting. Kelengkapan, keakuratan dan 

kemutakhiran suatu basis data spasial akan menentukan kualitas analisis dan 

produk akhir dari SIG. 

 

Metode yang paling umum digunakan untuk memasukkan data spasial ke dalam 

perangkat lunak SIG adalah dengan cara digitasi. Digitasi secara umum dapat 

didefinisikan sebagai proses konversi data analog ke dalam format digital. Peta 

analog (seperti peta topografi) atau dokumen lain dalam bentuk analog (seperti 

hasil interpretasi foto udara) dapat dimasukkan ke dalam perangkat lunak SIG 

dengan proses digitasi. 

 

Terdapat dua cara untuk melakukan proses digitasi: (i) digitasi menggunakan meja 

digitizer (on-tablet digitizing), (ii) digitasi pada layar komputer (on-screen 

digitizing). Digitasi dengan cara pertama (i) dilakukan dengan mengkonversi peta 

analog ke dalam bentuk data digital menggunakan meja digitizer. Cara kedua (ii) 

pada peta analog dilakukan proses pemindaian(scanning) untuk selanjutnya 

dilakukan proses digitasi langsung dari layar komputer, atau dengan 

menggunakan soft file peta analog yang sudah ada. 

 

Hasil dari proses digitasi ini adalah model data vektor yang berbentuk Shapefile 

(SHP). Shapefile adalah format file yang berbentuk vektor dan terdiri dari 4 jenis 

file yaitu shp, shx, dbf dan prj. SHP berisi kode binary, jadi jika file ini dibuka di 

notepad akan muncul angka atau huruf. Format file SHP ini dikeluarkan oleh 

ESRI, sebuah perusahaan yang bergerak dibidang perangkat lunak berbasis 

geografis. Salah satu file SHP yaitu prj berisi jenis proyeksi yang digunakan untuk 

mereferensikan koordinat agar saat dilakukan overlay data berada ditempat yang 

tepat (Wisnawa, 2008). 

 

Sebelum melakukan proses digitasi, kita harus melakukan proses Geokoreksi atau 

Georeferencing. Geokoreksi merupakan suatu proses untuk mengikat peta yang 

akan kita lakukan digitasi dengan sistem koordinat. Langkah ini dilakukan agar 

data digitasi tersebut dapat menunjukan letak sesungguhnya dipermukaan bumi. 

Menurut Prasetyo (2011) georeferencing merupakan proses penempatan objek 
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berupa raster atau image yang belum mempunyai acuan sistem koordinat ke 

dalam suatu sistem koordinat dan proyeksi tertentu. 

 

10.2. Tujuan Praktikum 

 

Tujuan dari praktikum ini adalah sebagai berikut: 

1. Praktikan mampu memahami serta melakukan proses 

digitasi/menjiplak/menggambarkan kondisi bumi atau peta ke dalam bidang 

datar. 

2. Praktikan mampu menganalisis dari kegunaan wilayah yang terdapat pada 

suatu peta melalui digitasi. 

 

10.3. Metodologi 

 

10.3.1 Connect Folder 

 

5. Buka software ArcGIS 

 

6. Pilih  untuk menghubungkan folder tersimpan dengan software ArcGIS. 

 

NB: jika tidak ada bar catalog. Klik  pada toolbar. 

 

7. Pilih folder yang akan dihubungkan dengan software ArcGIS →OK 
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10.3.2 Menampilkan Data 

1. Klik  pada toolbar →pilih data yang akan diolah →ADD 

 
 

10.3.3 Mengatur Sistem Koordinat 

 

4. Klik View→Data Frame Properties 

 
5. Klik Coordinate System →Predefined →Projected Coordinate System. 
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6. Pilih UTM →WGS 1984 →Southern Hemisphere →WGS 1984 UTM Zone 

48S →OK. 

 
 

10.3.4 Melakukan Geokoreksi 

 

8. Menyiapkan koordinat sistem yang akan digunakan untuk geokoreksi 

9. Zoom in  pada data yang akan digeokoreksi. 

10. Klik tools Add Control Points pada bagian bawah page. 
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11. Arahkan kursor bertanda + menuju daerah yang sesuai dengan titik 

koordinat. Klik pada wilayah yang sesuai lalu klik kanan dan pilih Input X 

dan Y.  

 

 
 

12. Masukan koordinat sesuai dengan titik X dan Y. 

 

13. Masukan koordinat sesuai kolom lalu klik OK 

 

 
Contoh: X= 506000, Y= 9399500 

NB: Klik kanan pada layer jpg, jika jpg tidak muncul. Klik kanan→Zoom To 

Layer. 

 
 

Akan muncul tanda + pada daerah yang telah dilakukan geokoreksi. Lakukan 

geokoreksi minimal sebanyak 4 titik yang menyebar merata diareal yang akan 

dipetakan.  
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14. Klik dibagian bawah layer untuk menyimpan data titik geokoreksi yang 

telah diambil. Jika Total RMS Error dibawah 0,10 maka proses geokoreksi 

sudah dilakukan dengan sangat baik. 

 

 
Jika nilai RMS (Root Mean Square) Errormenunjukan nilai yang rendah maka akan 

menghasilkan hasil rektifikasi (geokoreksi) yang akurat. Begitu juga sebaliknya, 

jika nilai RMSmenunjukan nilai yang tinggi maka akan menghasilkan hasil 

rektifikasi (geokoreksi) yang kurang akurat. Sebagai contoh, hasil transformasi 

boleh jadi masih berisi kesalahan yang signifikan karena rendah atau sedikitnya 

titik kontrol yang dimasukkan. 

 

NB:  Nilai RMS Error ditunjukan pada  lingkaran merah. 

 

15. Klik  seperti pada gambar untuk menyimpan titik GCP (Ground Control 

Point) atau titik geokoreksi. Pilih folder untuk menyimpan titik GCP → beri 

nama (GCP_Tahura)→SAVE 
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10.3.5 Membuat Shapefile 

 

1. Klik kanan pada folder penyimpanan yang berada di 

Catalog→New→Shapefile 

 
 

2. Ganti Nama:TAHURA, Feature Type: Polygon →Edit 
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NB: Edit digunakan untuk mengatur atau memberikan titik koordinat shapefile  

 

3. Klik Select →Projected Coordinate Systems →UTM →WGS 1984 

→Southern Hemisphere →WGS 1984 UTM Zone 48S →Add →Apply 

→OK. 

 
 

Pastikan bahwa koordinat sudah terisi dengan benar sesuai dengan koordinat peta 

yang akan didigitasi. 
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Jika shapefile telah dibuat akan muncul pada kolom Table of Contents seperti 

pada gambar dibawah. 

 
 

10.3.6 Melakukan Proses Digitasi 

 

1. Atur skala sebelum melakukan digitasi. Skala yang digunakan adalah 

1:25.000 

 
 

2. Klik Editor pada toolbar → Klik Start Editing 

 

3. Klik tools Create Features  pada toolbar Editor 

 

 



62 | P a g e  
 

 

4. Klik Shapefile TAHURA → lalu pilih POLYGON 

 

 
 

5. Proses digitasi sudah bisa dilakukan jika kursor sudah bertanda (+).  

 

Digitasi dilakukan dengan cara melakukan pointing (penitikan) atau penandaan 

pada daerah terluar yang ingin kita ambil. Proses penitikan mengikuti bentuk 

wilayah yang ingin kita ambil. Contoh lihat pada gambar dibawah. 

 

 
 

6. Lakukan penitikan mengelilingi wilayah, sampai bertemu dengan titik pertama 

atau titik awal. 
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7. Klik 2 kali untuk menghentikan proses digitasi. Tampilan akan seperti gambar 

dibawah ini 

 
 

8. Jika telah selesai klik Editor → Klik Stop Editing untuk menghentikan proses 

digitasi dan menyimpan data digitasi pada Shapefile yang telah dibuat. 

 
 

9. Tampilan hasil digitasi Peta Batas TAHURA WAN Abdul Rachman 
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10.3.6 Export Data Shapefile 

 

Export data shapefile ini digunakan untuk menggandakan batas wilayah 

TAHURA. Lebih detail dapat dijelaskan pada langkah berikut: 

 

1. Klik kanan pada file shapefile Tahura yang berada pada bar Table of 

Contents. Pilih Data→Export Data. 
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2. Pada Output Feature Class buat folder baru dengan nama TANAHdan 

simpan hasil eksport dengan nama TANAH. Klik Save→OK→Yes 

 

 
 

 

10.3.7 Menghilangkan Data Pada Table Of Contents 

 

1. Jika proses eksport telah selesai, data akan muncul pada Table of Contents 

(terlihat seperti pada gambar) 
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Untuk menghilangkan data atau meremove data, klik kanan pada data yang akan 

dihilangkan →pilih Remove.  

Kali ini kita meremove data TAHURA karena sudah tidak digunakan. Atau dapat 

juga dihilangkan ceklisnya saja untuk menonaktifkan data tersebut. 

 

 

10.3.8 Editing Data 

 

Untuk proses pengeditan data, ArcGIS menyediakan serangkaian fasilitas yang 

dikemas dalam toolbar Editor seperti berikut: 

 

 
 

 

10.3.9 Memotong Shapefile 

 

1. Klik yang bertanda lingkaran merah. 

Ini digunakan untuk mengganti warna Shapefile agar terlihat lebih jelas. 
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2. Pilih Hollow→Outline Width :1→Outline Color: Merah. Jika semua telah 

sesuai → Klik OK. 

 

 
 

3. Atur skala menjadi 1:25.000. Lakukan Zoom In pada wilayah yang akan 

dipotong. 

 

4. Klik Editor→Start Editing. Pilih polygon batas wilayah Tahura. 

Batas wilayah Tahura akan berubah warna menjadi biru muda seperti pada 

gambar dibawah. 
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5. Lakukan pemotongan polygon dengan tools Cut Polygons Tool. Klik tools 

 pada toolbar. 

Lakukan pemotongan polygon pada wilayah yang akan dipotong dengan cara 

penitikan pertama berada pada wilayah biru dan berakhir pada wilayah berwarna 

biru juga. 

 

 
 

6. Jika semua wilayah telah dilakukan penitikan. Klik 2 kali pada titik akhir di 

garis biru muda untuk mengakhiri proses pemotongan polygon. 

 

Wilayah yang akan dipotong 

Titik Awal Pemotongan Polygon 

Titik Akhir Pemotongan Polygon 
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Garis biru muda menandakan polygon telah terpotong. Lakukan pemotongan pada 

wilayah lainnya yang berwarna ungu. 

 

7. Hasil pemotongan jenis tanah pada peta tanah TAHURA WAN Abdul 

Rahman 

 
 

Jika dirasa pada saat mendigitasi polygonn tidak berada tepat pada batas kita 

dapat melakukan pengeditan dengan menggunakan tools Edit Vertices atau 

Reshape Feature Tool . 

 

Pengeditan Data Menggunakan Edit Vertices 

 

1. Pilih wilayah polygon yang perlu dilakukan pengeditan data. 
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2. Klik tools Editor →Start Editing.Lalu klik pada polygon yang akan 

dilakukan pengeditan. Pilih toolsEdit Vertices pada toolbar Editor. Tampilan 

akan seperti pada gambar dibawah.  

 

3. Lakukan pemindahan pada titik berwarna hijau. Geser titik berwarna hijau 

sesuai dengan tujuan pengeditan yang dilakukan. 

 

 
 

4. Jika telah selesai memindahkan titik – titik hijau polygon sesuai dengan 

tujuan. Klik sekali diluar polygon untuk melihat hasil pengeditan. Tampilan 

akan seperti gambar dibawah ini.  
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5. Lakukan pengeditan data pada seluruh wilayah yang perlu untuk dilakukan 

pengeditan. 

 

6. Jika telah selesai klik tools Editor →Stop Editinglalu klik YESuntuk 

menyimpan hasil editing. 

 

Pengeditan Data Menggunakan Reshape Feature Tool. 

 

1. Pilih wilayah polygon yang perlu dilakukan pengeditan data. 

 

 
 

2. Klik tools Editor →Start Editing.Lalu klik pada polygon yang akan 

dilakukan pengeditan. Pilih tools Reshape Feature Tool pada toolbar Editor. 

Tampilan akan seperti pada gambar dibawah.  

 

 
 

 

3. Buat pola seperti pada gambar dibawah untuk menarik polygon kedalam, 

sesuai dengan batas wilayah. Klik 2 kali pada titik akhir untuk mengakhiri 

pengeditan data. 

 



72 | P a g e  
 

 
 

4. Lakukan proses tersebut sampai semua polygon berada pada batas wilayah 

yang sesuai. Seperti pada gambar dibawah ini.  

 

 
 

5. Lakukan pengeditan data pada seluruh wilayah yang perlu untuk dilakukan 

pengeditan. 

 

6. Jika telah selesai klik tools Editor →Stop Editinglalu klik YESuntuk 

menyimpan hasil editing. 

 

 

Tugas 

Buat laporan praktikum dalam buku praktikum kelompok ! 

 

 

 

 

 

 

 

Titik Awal 

Titik Akhir 



73 | P a g e  
 

BAB XI 

PEMBERIAN ATRIBUT DAN QUERY 

 

11.1  Dasar Teori 

 

Seperti yang telah dijelaskan diawal bahwa terdapat 2 jenis data dalam Sistem 

Informasi Geografis, yaitu data spasial dan data atribut. Salah satu bagian penting 

dalam SIG ialah pengetahuan tentang database atau data atribut. Data atribut 

berfungsi untuk menerangkan isi yang berada di dalam suatu data spasial (feature 

atau raster data) dalam bentuk tabel. Baik data vektor maupun data raster sama-

sama memiliki data atribut untuk memberikan informasi diri dari data tersebut dan 

bisa menjadi pembeda dengan data lainnya (Prasetyo, 2011). 

 

Data atribut berbentuk tabel atau biasa disebut dengan tabel atribut. Tabel atribut 

merupakan tabel yang dapat menampilkan data-data yang terdapat dalam fitur dan 

dapat diakses baik dalam mode editing maupun dalam mode biasa. Pada 

komponen tabel atribut layer menampilkan serupa dengan worksheet atau tabel, 

dimana record data diperlihatkan dalam arah mendatar (baris) sedangkan field 

diperlihatkan dalam arah vertikal (kolom). Sel adalah bagian terkecil dari tabel 

atribut. Pada suatu tabel atribut data spasial, 1 record mewakili 1 fitur (Anwar, 

2002). 

 

Untuk kepentingan tertentu dibutuhkan informasi mengenai data-data apa saja 

yang tercakup dalam peta tersebut. Untuk mengetahui secara khusus suatu 

informasi, kita dapat melakukan query. Query dapat diartikan sebagai proses 

memilih sebuah atau beberapa bagian data untuk berbagai keperluan tertentu. 

Seperti contoh ingin mengetahui lokasi dan informasi (atribut) dari suatu feature.  

 

Ada beragam cara untuk mendapatkan informasi dari peta di ArcMap. Dapat 

menggunakan identify tool, atau selection tool untuk memilih suatu obyek 

kemudian dilihat atribut yang terpilih, atau dengan menggunakan query (atribut 

dan spasial).  

a. Identify adalah sebuah tool dalam aplikasi ArcMap yang digunakan untuk 

mengidentifikasi informasi detil dari setiap objek pada peta.  

b. Selection digunakan untuk melakukan query satu atau beberapa feature yang 

letaknya berhubungan antara satu dengan lainnya. 

c. Query atribut, untuk mengidentifikasi, mencari, dan memilih obyek. Pengguna 

bisa menggunakan query yang secara otomatis memilih obyek yang sesui 

dengan kriteria tertentu. Query tersebut berupa Structured Query Language 

(SQL). 
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d. Query spasial, pencarian obyek juga bisa dilakukan berdasarkan lokasi/ posisi 

relatifnya (hubungan spatialnya) terhadap obyek lain baik dalam satu layer 

maupun beda layer. 

 

 

11.2 Tujuan Praktikum 

 

Tujuan dari praktikum ini adalah sebagai berikut: 

1. Praktikan mampu melakukan proses query data atau pemberian atribut pada 

feature peta yang telah didigitasi. 

2. Praktikan dapat memahami arti penting pemberian data pada peta. 

 

11.3 Langkah Kerja 

 

Ada beragam cara untuk mendapatkan informasi dari peta di ArcMap. Dapat 

menggunakan Identify Tool , atau Selection Tool  untuk memilih suatu 

obyek kemudian dilihat atribut yang terpilih, atau dengan query. 

 

 
 

11.3.1 Mencari Informasi Menggunakan Identify Tool 

1. Klik tool Identify  pada toolbars Tools. 

 

2. Lalu klik pada polygon yang ingin diketahui informasinya. Maka akan muncul 

tabel informasi tentang polygon yang telah dipilih seperti gambar dibawah ini. 

 

 

 

 

11.3.2  Mencari Informasi Menggunakan Selection Tool 

 

a. PETA TANAH 

 



75 | P a g e  
 

1. Klik kanan pada data Shapefile yang ingin diketahui informasinya yang 

berada di Table of Contents. Lalu pilih Open Attribute Table. 

 

 
 

 

2. Klik tool Selection Tool pada toolbars Tools. Pilih Select by 

Rectangle. 

 

 
 

 

3. Klik pada polygon yang ingin diketahui informasinya. 

 

 
 

 

4. Data yang terpilih pada Attribute Table akan berwarna biru muda seperti 

pada gambar. 
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b. PETA LERENG 

 

1. Klik kanan pada data Shapefile yang ingin diketahui informasinya yang 

berada di Table of Contents. Lalu pilih Open Attribute Table. 

 

 
 

2. Klik tool Selection Tool pada toolbars Tools. Pilih Select by Rectangle. 

 

 
 

3. Klik pada polygon yang ingin diketahui informasinya. 

 



77 | P a g e  
 

 
 

4. Data yang terpilih pada Attribute Table akan berwarna biru muda seperti 

pada gambar. 

 

 
 

c. PETA IKLIM 

 

1. Klik kanan pada data Shapefile yang ingin diketahui informasinya yang 

berada di Table of Contents. Lalu pilih Open Attribute Table. 

 

 

2. Klik tool Selection Tool pada toolbars Tools. Pilih Select by 

Rectangle. 
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3. Klik pada polygon yang ingin diketahui informasinya. 

 

 
 

4. Data yang terpilih pada Attribute Table akan berwarna biru muda seperti 

pada gambar. 

 
 

 

11.3.3 Menambahkan Data Atribut 

 

Penambahan data attribute ini difungsikan untuk memberikan informasi tambahan 

terkait data spasial yang kita olah. Untuk memberikan informasi tambahan yang 

perlu dilakukan adalah 

 

a. PETA TANAH 

 

1. Klik kanan pada Shapefile yang ingin ditambahkan informasinya.Lalu pilih 

Open Attribute Table. 

 



79 | P a g e  
 

 
 

2. Pada Table klik Table Options lalu pilih Add Field. 

 

 
 

3. Name: Klasifikasi, Type: Text, Precision: 20 lalu klik OK. 

 

 
 

4.Klik tool Selection Tool  pada toolbars Tools. Pilih Select by Rectangle. 

Pilih polygon yang ingin ditambahkan informasinya. 
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5. Lalu klik kanan pada kolom Klasifikasi, lalu pilih Field Calculator lalu 

klik YES. 

 

 
 

6. Masukan informasi yang ingin diberikan. Contoh: ”Dystrandepts” lalu 

klik OK. 

NB: Menggunakan apostrof (”...”) karena jenisnya text. 

 

 
 

7. Lakukan sampai semua polygon diberikan informasi. 
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- Menghitung Luas 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 

 

 
 

2. Name: Luas,Type: Double, Precision: 5, Scale: 5 

 

 
 

3. Klik kanan pada kolom Luas lalu pilih ”Calculate Geometry” →Yes 
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4. Pilih “Use Coordinate System of The Data Source” dan untuk Units 

pilih “Ha” atau satuan yang lainnya lalu OK→Yes. 

 

 
 

5. Tampilan akan menjadi seperti ini 

 
 

- Pemberian Keterangan 

 

Jenis tanah ”Dystropepts dan Dystrandepts” termasuk kedalam jenis tanah yang 

mempunyai sifat ”Tidak Peka”.  

 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 
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2. Name: Keterangan, Type: Text, Field Properties: 20 lalu klik OK 

 

 
 

Karena jenis tanah ”Dystropepts dan Dystrandepts” memiliki sifat yang sama 

sama ”Tidak Peka” maka kita dapat memasukan semua keterangannya secara 

bersamaan. 

 

3. Klik kanan pada kolom Keterangan lalu pilih Field Calculator→Yes. 

 

 
 

4. Pada kolom keterangan isi ”Tidak Peka” lalu klik OK 
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5. Tampilan akan menjadi seperti ini 

 

 
 

- Pemberian Skor 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 

 

 
 

2. Name: Skor, Type: Double lalu klik OK. 
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3. Klik kanan pada kolom Skor lalu pilih ”Field Calculator” →Yes 

 

 
 

4. Isi nilai skor sesuai dengan jenis tanah. Untuk jenis tanah Dystrandepts dan 

Dystropepts memiliki skor 30 menurut skor kelas lahan Peraturan Menteri 

Pertanian No. 837 tahun 1980 (Permentan 837/1980) lalu klik OK. 

 

 
 

5. Tampilan hasil keseluruhan 
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- Menampilkan Data 

 

Jika semua data sudah diberikan keseluruhan pada data atribut 

 

1. Klik kanan pada data “Shapefile Tanah” di Table of Contents lalu pilih 

“Properties” 

 
 

2. Pilih “Symbology” lalu “Categories” dan pilih“Unique Values”. Pada 

Value Field kita dapat memilih data mana yang akan kita tunjukan. Untuk 

saat ini kita memilih data Nama Tanah. 
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3. Setelah memilih “Nama” pada Value Field lalu klik “Add All Values” pada 

Color Ramp kita dapat memilih warna yang kita inginkan. Jika semua telah 

diatur klik OK. 

 

 
 

4. Tampilan akan menjadi seperti ini. 

 

 
- Pemberian Label 

 

1. Untuk memberikan label pada data klik kanan pada ”ShapefileTanah” pilih 

”Label Features”.  
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Jika data label nama tanah tidak keluar, maka lakukan cara dibawah ini. 

 

2. Lalu klik kanan → pilih Properties. 

 

 
3. Klik ”Labels” dibagian atas. Pada label field pilih ”Klasifikasi” lalu klik OK 

 

 

4. Tampilan akan seperti ini 
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b. PETA LERENG 

 

1. Klik kanan pada Shapefile yang ingin ditambahkan informasinya.  Lalu pilih 

Open Attribute Table. 

 

 
 

2. Pada Table klik Table Options lalu pilih Add Field. 
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3. Name: Klasifikasi, Type: Text, Precision: 20 lalu klik OK. 

 

 
 

4. Klik tool Selection Tool  pada toolbars Tools. Pilih Select by Rectangle. 

Pilih polygon yang ingin ditambahkan informasinya. 

 

 
 

5. Lalu klik kanan pada kolom Jenis Tanah, lalu pilih Field Calculator lalu klik 

YES. 

 

 
 

6. Masukan informasi yang ingin diberikan. Contoh: ”15 – 30%” lalu klik OK. 

NB: Menggunakan apostrof (”...”) karena jenis datanya text. 
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7. Lakukan sampai semua polygon diberikan informasi. 

 

 
 

- Menghitung Luas 

 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 
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2. Name: Luas,Type: Double, Precision: 5, Scale: 5 

 
 

3. Klik kanan pada kolom Luas lalu pilih ”Calculate Geometry” →Yes 

 

 
 

4. Pilih “Use Coordinate System of The Data Source” dan untuk Units pilih 

“Ha” atau satuan yang lainnya lalu OK→Yes. 

 

 
 

5. Tampilan akan menjadi seperti ini 
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- Pemberian Keterangan 

 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 

 

 
 

2. Name: Keterangan, Type: Text, Field Properties: 20 lalu klik OK 
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3. Pilih polygon yang akan diisi keterangan dengan cara, klik dibagian yang 

diberi titik merah pada gambar. Polygon terpilih akan berwarna biru. 

 
 

4. Klik kanan pada kolom Keterangan lalu pilih Field Calculator→Yes. 

 

 
 

5. Pada kolom ”Keterangan” isi sesuai dengan ”Kelas Klasifikasi”. Pada 

contoh Klasifikasi 15-30% masuk dalam kategori ”Agak Curam”. Setelah 

mengisi kolom keterangan , maka klik OK. 
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6. Kolom akan terisi seperti pada gambar 

 

 
 

7. Isi semua kolom sesuai dengan kelas klasifikasi. Maka tampilan akan menjadi 

seperti dibawah ini. 

 
 

- Pemberian Skor 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 
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2. Name: Skor, Type: Double lalu klik OK. 

 

 
 

3. Pilih polygon yang akan diisi keterangan dengan cara, klik dibagian yang 

diberi titik merah pada gambar. Polygon terpilih akan berwarna biru. 

 

 
 

4. Klik kanan pada kolom Keterangan lalu pilih Field Calculator→Yes. 

 

 
 

5. Pada kolom ”Skor” isi sesuai dengan ”Kelas Klasifikasi”. Pada contoh 

Klasifikasi 15-30% memiliki skor ”60”. Setelah mengisi kolom skor, maka 

klik OK. 
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6. Kolom akan terisi seperti pada gambar 

 

 
 

7. Isi semua kolom sesuai dengan kelas klasifikasi. Maka tampilan akan menjadi 

seperti dibawah ini. 
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- Menampilkan Data 

 

Jika semua data sudah diberikan keseluruhan pada data atribut. Remove data JPG 

Peta Lereng. Klik kanan pada Lereng. JPG lalu pilih Remove. 

 

1. Klik kanan pada data “Shapefile Lereng” di Table of Contents lalu pilih 

“Properties”. 

 

 
 

2. Pilih “Symbology” lalu “Categories” dan pilih“Unique Values”. Pada 

Value Field kita dapat memilih data mana yang akan kita tunjukan. Untuk 

saat ini kita memilih data “Klasifikasi”. 
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3. Setelah memilih “Klasifikasi” pada Value Field lalu klik “Add All Values” 

pada Color Ramp kita dapat memilih warna yang kita inginkan. Jika semua 

telah diatur klik OK. 

 

 
 

4. Tampilan akan menjadi seperti ini. 
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- Pemberian Label 

 

1. Untuk memberikan label pada data klik kanan pada ”ShapefileLereng” pilih 

”Label Features”. 

 
 

Jika data label nama tanah tidak keluar, maka lakukan cara dibawah ini. 

 

2. Lalu klik kanan → pilih Properties. 

 

 
 

3. Klik ”Labels” dibagian atas. Pada label field pilih ”Klasifikasi” lalu klik 

OK. 
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4. Tampilan akan seperti ini 

 
 

c. PETA IKLIM 

 

1. Klik kanan pada Shapefile yang ingin ditambahkan informasinya.  Lalu pilih 

Open Attribute Table. 
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2. Pada Table klik Table Options lalu pilih Add Field. 

 

 
 

3. Name: Klasifikasi, Type: Text, Precision: 20 lalu klik OK 

 
 

4. Klik tool Selection Tool  pada toolbars Tools. Pilih Select by Rectangle. 

Pilih polygon yang ingin ditambahkan informasinya. 

 

 
 

5. Lalu klik kanan pada kolom Klasifikasi, lalu pilih Field Calculator lalu klik 

YES. 
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6. Masukan informasi yang ingin diberikan. Contoh: ”1.800 – 1.700 mm” lalu 

klik OK. 

NB: Menggunakan apostrof (”...”) karena jenisnya text. 

 
 

7. Lakukan sampai semua polygon diberikan informasi. 
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- Menghitung Luas 

 

1. Pada Table Attributeklik Table Options lalu pilih Add Field. 

 
 

2. Name: Luas,Type: Double, Precision: 5, Scale: 5 

 

 
 

3. Klik kanan pada kolom Luas lalu pilih ”Calculate Geometry” →Yes 
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4. Pilih “Use Coordinate System of The Data Source” dan untuk Units pilih 

“Ha” atau satuan yang lainnya lalu OK→Yes. 

 

 
 

5. Tampilan akan menjadi seperti ini. 

 

 
 

- Pemberian Keterangan 

 

Intensitas Curah Hujan keseluruhan klasifikasi masuk dalam kategori Curah 

Hujan yang “Sangat Rendah”. 

 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 
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2. Name: Keterangan, Type: Text, Field Properties: 20 lalu klik OK 

 

 
 

Karena semua kelas Curah Hujan masuk kedalam intensitas yang ”Sangat 

Rendah”, maka kita dapat memasukan semua keterangannya secara bersamaan 

 

3. Klik kanan pada kolom Keterangan lalu pilih Field Calculator→Yes. 

 

 
 

4. Pada kolom keterangan isi ”Sangat rendah” lalu klik OK 
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5. Tampilan akan menjadi seperti ini. 

 

 
 

- Pemberian Skor 

 

1. Pada Table Attribute klik Table Options lalu pilih Add Field. 
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2. Name: Skor, Type: Double lalu klik OK. 

 

 
 

3. Klik kanan pada kolom Skor lalu pilih ”Field Calculator” →Yes 

 

 
 

4. Isi nilai skor sesuai dengan klasifikasi curah hujan. Untuk keseluruhan kelas 

curah hujan memiliki skor 10 menurut skor Kementan lalu klik OK. 
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5. Tampilan hasil keseluruhan. 

 

 
 

- Menampilkan Data 

 

Jika semua data sudah diberikan keseluruhan pada data atribut. Remove data JPG 

Peta Iklim. Klik kanan pada Iklim. JPG lalu pilih Remove. 

 

1. Klik kanan pada data “Shapefile Iklim” di Table of Contents lalu pilih 

“Properties” 

 

 
 

2. Pilih “Symbology” lalu “Categories” dan pilih “Unique Values”. Pada 

Value Field kita dapat memilih data mana yang akan kita tunjukan. Untuk 

saat ini kita memilih data Klasifikasi. 
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3. Setelah memilih “Nama” pada Value Field lalu klik “Add All Values” pada 

Color Ramp kita dapat memilih warna yang kita inginkan. Jika semua telah 

diatur klik OK. 

 

 
 

4. Tampilannya akan seperti ini. 
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- Pemberian Label 

 

1. Untuk memberikan label pada data klik kanan pada ”Shapefile Iklim” pilih 

”Label Features”. 

 
 

Jika data label nama tanah tidak keluar, maka lakukan cara dibawah ini. 

 

2. Lalu klik kanan → pilih Properties. 
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ù  

 

3. Klik ”Labels” dibagian atas. Pada label field pilih ”Klasifikasi” lalu klik OK 

 

 

 
 

4. Tampilan akan seperti ini 
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Tugas 

Buat laporan praktikum dalam buku praktikum kelompok ! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



114 | P a g e  
 

BAB XII 

ANALISIS SPASIAL 

 

12.1  Dasar Teori 

 

Analisis spasial merupakan keunggulan yang diberikan oleh SIG dalam 

menganalisis gabungan dari bermacam tema spasial (misalnya peta dasar, peta 

tematik, data inderaja, dll) untuk menghasilkan informasi baru melalui 

serangkaian proses perhitungan (algoritma). Analisis spasial lebih sering disebut 

overlay oleh khalayak, walaupun tidak seluruhnya operasi pada analisis spasial 

berdasarkan pada analisis overlay.Overlay merupakan kemampuan proses 

penyatuan data dari lapisan (layer) yang berbeda, secara sederhana overlay 

disebut sebagai operasi visual yang membutuhkan lebih dari satu lapis data untuk 

digabungkan secara fisik (Budiyanto, 2002).Analisis overlay ini digunakan untuk 

mengetahui batas atau perubahan dari masa ke masa. Untuk menyusun rencana 

pembangunan yang tepat dibutuhkan informasi yang lengkap dan akurat tentang 

berbagai masalah dan potensi sumber daya alam yang terkandung dalam suatu 

wilayah yang bersangkutan (Ekadinata, 2013). Analisis overlay biasanya 

dilakukan untuk memberikan solusi terkait perencanaan pembangunan tersebut. 

 

Pemahaman bahwa overlay peta terdiri dari minimal 2 peta harus menghasilkan 

peta baruadalah hal mutlak. Jika dilihat dari data atributnya, maka akan terdiri dari 

informasi peta pembentukannya. Misalnya dilakukan overlay peta tanah, peta 

lereng, dan peta iklim maka hasil dari proses tersebut adalah poligon baru yang 

berisi atribut peta tanah, peta lereng dan peta iklim (Novifa, 2013). Teknik yang 

digunakan untuk overlay peta dalam SIG ada beberapa macam (misalnya: union, 

intersect, identity, dll), akan tetapi yang sering digunakan ada 2 jenis yakni 

uniondan intersect. Jika dianalogikan dengan bahasa matematika, maka union 

adalah gabungan dan intersect adalah irisan (Nurshanti, 1995).Dengan melakukan 

overlay peta didapatkan juga overlay data dalam bentuk tabel hasil dari proses 

overlaytersebut (Trisasongko, 2012) 

. 

12.2. Tujuan Praktikum 

 

Tujuan dari praktikum ini adalah sebagai berikut: 

1. Praktikan mampu melakukan teknik overlay secara benar. 

2. Praktikan mampu menggabungkan informasi dengan benar sesuai dengan 

tujuan overlay. 

 

12.3.  Langkah Kerja 

 

- Menampilkan Data 
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1. Keluarkan semua data yang akan di-overlay didalam layer. Data yang akan di-

overlay (Shapefile Tanah, Lereng dan Iklim) 

 

 
2. Klik “Geoprocessing” pada toolsbar lalu klik ”Union”. 

 

 
 

3. Klik Input Features lalu pilih data yang akan di-overlay, sampai dengan 

kolom Features terisi dengan semua data. Output Feature Class untuk 

menyimpan data hasil overlay. Lalu klik OK. 

 
 

4. Tunggu prosesnya sampai selesai. 
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5.  Data akan muncul pada “Table of Contents”. 

 

 
 

6. Setelah data overlay muncul pada Table of Contents. Kita dapat menghapus 

data shapefile yang lain (tanah, lereng, iklim) dengan cara klik Kanan pada 

Shapefile lalu klik Remove. 

 
 

Maka hanya akan ada data overlay pada “Table of Contents” 

 

 
 

- Analisis Data (Penghitungan Skor) 

 

1. Klik kanan pada Data Overlay lalu pilih “Open Attribute Table”. 
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2. Pilih “Table Options” lalu klik “Add Field” 

 

 
 

3. Name: Skor Total, Type: Double lalu klik OK. 

 
 

4. Klik kanan pada kolom “Skor Total” lalu pilih ”Field Calculator”→Yes. 

 

 
 

Menghitung “Skor Total” dilakukan dengan cara menjumlahkan nilai skor. 

Penaman pada gambar Skor Tanah ”Skor” Skor Iklim ”Skor_1” Skor Lereng 

”Skor_12”. 
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5. Kolom ”Skor_Total” diisi dengan cara klik 2 kali ditulisan ”Skor” dalam 

”Fields” lalu klik tanda (+) untuk menjumlah. Lalu klik lagi 2 kali ”Skor_1” 

pada ”Fields” lalu klik tanda (+),lakukan sampai semua skor menjadi seperti 

ini ”[Skor] + [Skor_1] + [Skor_12]” lalu klik Ok. 

 

 
 

6. Maka tampilan akan muncul seperti dibawah ini. 

 
 

- Analisis Data (Penetapan Status Kawasan) 

 

Penetapan kawasan hutan mengacu pada Peraturan Mentri Pertanian No. 

837/Kpts/Um/11/1980. Dengan kriteria dibawah ini 
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Status Kawasan Kriteria 

Hutan Lindung Skor Lansekap > 174 

Hutan Produksi Terbatas Skor Lansekap < 174 dan Skor > 124 

Hutan Produksi Tetap Skor Lansekap < 124 

 

1. Pilih “Table Options” lalu klik “Add Field” 

 

 
 

2. Name: Status_Kawasan, Type: Text, Field Properties: 25.  

 

 
3. Akan muncul kolom “Status Kawasan”.  

 

 
 



120 | P a g e  
 

4. Untuk mengisi kolom “Status Kawasan” pilih Table Options lalu klik Select 

By Attributes 

 
 

5. Akan muncul seperti pada gambar dibawah ini. Pada Select by Attributes 

klik 2 kali pada bagian Skor Total lalu klik 2 kali tanda (<) lalu tulis sesuai 

dengan ”Kriteria” lalu Apply. 

 

Rumus yang digunakan: 

- Hutan Lindung: "Skor_Total" > 174 

- Hutan Produksi Terbatas: "Skor_Total" <= 174 AND "Skor_Total" > 124 

- Hutan Produksi Tetap:"Skor_Total" <= 124 

 

 
 

6. Untuk melihat terdapat data yang terpilih atau tidak, dapat dilihat pada 

lingkaran merah di gambar. Tertulis bahwa terdapat ”76 data” dengan ”55 

data” yang terpilih 
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7. Klik kanan kolom Status Kawasan dan pilih Field Calculator→Yes. 

 

 
 

8. Karna skor :"Skor_Total" <= 124masuk dalam status kawasan Hutan 

Produksi Tetap maka kita tulis ”Hutan Produksi Tetap” lalu klik OK. 

 
 

9. Lakukan sampai semua kategori terisi, maka tampilan akan seperti gambar 

dibawah ini. 
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Tugas 

Buat laporan praktikum dalam buku praktikum kelompok ! 
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BAB XIII 

LAYOUT DATA (KARTOGRAFI) 

 

13.1 Dasar Teori 

 

Layout peta merupakan pekerjaan terakhir setelah proses overlay atau analisis 

data. Fasilitas layout dapat menampilkan dan mengatur data mana saja yang akan 

digunakan sebagai output dari proses atau analisis GIS (Hariyanto, 2012). 

Pembuatan peta ini sering disebut sebagai kartografi atau seni pembuatan peta. 

Kartografi merupakan suatu pembuatan peta yang memproyeksikan gambaran 

bumi dalam bentuk dua dimensi. Kartografi juga dapat diartikan sebagai ilmu 

dalam pembuatan peta dalam hal ini pembuatannya dibantu oleh komputer 

(Gularso, 2013).  

 

Sebuah layout peta dapat bekerja dan mencapai tujuannya bila pesan-pesan yang 

akan disampaikan dapat segera ditangkap dan dipahami. Kelebihan layout 

diantaranya yaitu mudah, terutama untuk pemula, adapun kekurangannya yaitu 

cukup rumit dan ukuran filenya besar sehingga beberapa bowser tidak terlalu 

cepat dalam menampilkannya (Hidayati, 2010). Secara umum fungsi peta dapat 

disimpulkan sebagai berikut: 

a. Menunjukan posisi atau lokasi suatu tempat dipermukaan bumi 

b. Memperlihatkan ukuran (luas, jarak) dan arah suatu tempat dipermukaan 

bumi 

c. Menggambarkan bentuk-bentuk dipermukaan bumi 

d. Membantu peneliti sebelum melakukan survei untuk mengetahui kondisi 

daerah yang akan diteliti 

e. Menyajikan data tentang potensi suatu daerah 

f. Alat analisis untuk mendapatkan suatu kesimpulan (Aldina, 2001) 

 

13.2 Tujuan Praktikum 

 

Tujuan dari praktikum ini adalah sebagai berikut: 

1. Praktikan memahami cara pembuatan peta (kartografi). 

2. Praktikan dapat melakukan kartografi digital menggunakan software ArcGIS. 

 

13.3 Langkah Kerja 

 

- Menampilkan Data 

 

1. Klik Kanan pada Shapefile Data Overlay pilih Properties. 
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2. Pilih Symbology klik Categories lalu Unique Values. Pada kolom Value 

Field pilih Status_Kawasan lalu klik Add All Values pada Color Ramp 

pilih warna yang diinginkan lalu klik OK.  

 

 
 

3. Maka tampilan akan menjadi seperti ini. 
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- Pemberian Label 

 

1. Klik kanan pada Shapefile Data Overlay lalu klik Label Features. 

 

 
 

2. Klik kanan pada Shapefile Data Overlay lalu klik Properties. 

 

 
 

3. Pilih Labels pada Label Field pilih Status Kawasan lalu klik Placement 

Properties. 
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4. Pada Placement Properties pilih seperti yang terdapat pada gambar lalu klik 

OK dan Apply. 

 

 
 

5. Maka tampilan akan seperti pada gambar. 
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- Layout Peta 

 

1. Klik File lalu pilih Page and Print Setup. 

 

 
 

2. Pada Paper Size kita dapat mengatur ukuran kertas dan pada Orientation kita 

dapat mengatur bentuk kertas yang kita gunakan. Untuk saat ini kita 

menggunakan bentuk kertas Landscape. Jika sudah diatur semua kita dapat 

klik OK. 
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3. Pilih View pada toolbar lalu klik Layout View. 

 

 
 

4. Kita dapat menarik garis yang terdapat dikotak merah pada gambar dengan 

menyesuaikan ukuran peta. Kotak tersebut digunakan untuk wadah data yang 

akan kita tampilkan. 
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5. Maka akan menjadi seperti pada gambar dibawah 

 
 

6. Atur skala untuk mengatur besar gambar yang akan ditampilkan. Pengaturan 

skala dapat dilakukan dibagian toolbar, pada bar skala kita dapat mengatur 

skala yang kita inginkan. 
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Pada praktikum kali ini kita menggunakan skala 1:120.000. Penggunaan skala ini 

disesuaikan dengan kebutuhan kita untuk menampilkan data. Gunakan skala yang 

sesuai dengan besar data yang akan kita tampilkan.  

 

 
 

7. Untuk pemberian judul pada peta yang akan kita buat klik Insert lalu pilih 

Title. 

 

 
 

8. Isi kolom sesuai dengan judul peta yang kita buat. Untuk saat ini judul petanya 

adalah ”PETA PENENTUAN KAWASAN TAMAN HUTAN RAYA 

WAN ABDUL RACHMAN”lalu klik OK.  
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9. Untuk melakukan edit pada judul kita dapat menggunakan toolbar ”Draw”. 

Kita dapat mengatur Ukuran dan Font yang digunakan atau Tebal, Miring 

dan Garis Bawah. 

 

 
 

10. Tampilan setelah diberi judul peta akan menjadi seperti ini. 

 

 
 

11. Pemberian Arah Mata Angin. Klik Insert lalu pilih North Arrow. 
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12. Terdapat beberapa pilihan Arah Mata Angin yang dapat digunakan. Pilih 

yang menurut kalian bagus, pemilihan sesuai selera. Jika sudah klik pada 

gambar yang telah dipilih lalu klik OK. 

 

 
 

13. Tampilan akan menjadi seperti pada gambar. Peletakan Arah Mata Angin 

dapat disesuaikan dengan keinginan. Ukuran Arah Mata Angin juga dapat 

dibesarkan atau dikecilkan. 
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14. Pemberian skala. Terdapat 2 jenis skala yaitu Skala Bar dan Skala Text. 

Pemilihan penggunaan skala tergantung dari keinginan. Untuk pemberian 

skala klik Insert lalu pilih Skala Bar atau Skala Text, untuk praktikum ini 

kita menggunakan Skala Bar. 

 

 
 

15. Terdapat beberapa pilihan Skala Baryang dapat digunakan. Pilih yang 

menurut kalian bagus, pemilihan sesuai selera. Jika sudah klik pada gambar 

yang telah dipilih lalu klik Properties. 
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Kita dapat mengatur pada Division Units ingin dalam bentuk satuan Kilometer, 

Meter atau yang lainnya. Pada Label kita dapat mengatur label yang digunakan 

Kilometer atau Km, Meter atau M. Jika sudah klik OK dan OK. 

 

 
 

16. Tampilan akan menjadi seperti pada gambar. Peletakan Skala Bar dapat 

disesuaikan dengan keinginan. Ukuran Skala Bar juga dapat dibesarkan atau 

dikecilkan 
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17. Pemberian Legenda atau Keterangan dilakukan dengan cara klik Insert pada 

toolbar lalu pilih Legend. 

 
 

18. Isi Legend Items dengan cara memindahkan data yang terdapat di Map 

Layers yang akan digunakan sebagai data legenda dengan mengklik data 

tersebut lalu klik tanda . Maka secara otomatis data tersebut akan 

berpindahke Legend Items lalu klik Next. 
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19. Legend Title: Keterangan: Color, Size dan Font dapat diatur sesuai 

keinginan. Setelah diatur klik Next sampai data Legenda muncul dilayer. 

 

 
 

20. Klik Kanan pada keterangan lalu klik Convert To Graphics. 
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21. Klik Kanan pada keterangan lalu klik Ungroup. 

 
 

22. Hapus Data Overlaydan Status Kawasan, lalu rapikan tiap bagiannya. 

 

 
 

23. Blok seluruh keterangan lalu klik Kanan dan pilih Group. 

 

 
 

24. Tampilan akan menjadi seperti pada gambar. 
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a  

 

25. Pemberian informasi tambahan seperti sumber data, pembuat peta dan lain-

lain. Klik Insert pada toolbar lalu pilih Text. 

 

 
 

26. Klik 2 kali pada kolom yang telah tersedia. Ketik informasi yang ingin 

diberikan. Dalam praktikum ini keterangan yang akan ditambahkan adalah 

Sumber Data, Pembuat Peta, dan Proyeksi Peta. Pada kolom Text masukan 

informasi yang ingin kita tambahkan lalu klik OK. 
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27. Tampilan akan menjadi seperti ini. 

 

 
 

28. Pemberian Grid dilakukan dengan cara, klik data shapefila lalu klik Kanan 

lalu pilih Properties. 
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29. Pilih ”Grid”→”New Grid”→”Measured Grid” lalu Next. 
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30. Pilih Grid and Labelsklik Next lalu OK. 

 

 
 

31. Klik pada data shapefile lalu klik Kanan lalu pilih Properties. 
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32. Data Frame Properties: Properties, Reference System Properties: Additional 

Properties, Grid Label Properties: Number Format, Number Format 

Properties dari 6 diganti menjadi 0 lalu klik OK. 

 

 
 

33. Tampilan akan seperti dibawah ini. 
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34. Pemberian garis tepi pada peta atau Neatline. Pilih Insert pada toolbarlalu 

klik  Neatline. 

 

  
 

35. Pilih “Place around all elements” lalu klik OK. 
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36. Tarik garis hitam menuju ke garis tepi peta. 

 

 
 

37. Tampilan akan menjadi seperti ini. 
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38. Eksport data peta dilakukan dengan cara klik File pada toolbar lalu pilih 

Export Map. 
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39. Eksport data peta sesuai dengan folder penyimpanan. File Name: PETA 

KAWASAN TAHURA WAR, Save as type: JPEG (*JPG), Resolution: 300 

lalu klik Save. 

 

 
 

40. Hasil Akhir. 

 

 

Tugas 

Buat laporan praktikum dalam buku praktikum kelompok ! 
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